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This section of the User’s Guide provides instruction on using the Natural Gas and Oil 
Systems module of the State Inventory Tool (SIT), and describes the methodology used for 
estimating greenhouse gas emissions from natural gas and oil systems at the state level. 
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1.1 GETTING STARTED 

The Natural Gas and Oil Systems module was developed using Microsoft® Excel 2000. While 
the module will operate with older versions of Excel, it functions best with Excel 2000 or 
later. If you are using Excel 2007 or later, instructions for opening the module will vary as 
outlined in the Excel basics below. Some of the Excel basics are outlined in the sections 
below. Before you use the Natural Gas and Oil Systems module, make sure your computer 
meets the system requirements. In order to install and run the Natural Gas and Oil Systems 
module, you must have: 

• IBM-PC compatible computer with the Windows 95 operating system or later; 

• Microsoft® Excel 1997 or later, with calculation set to automatic and macros 
enabled; 

• Hard drive with at least 20MB free; and 

• Monitor display setting of 800 x 600 or greater. 

Microsoft Excel Settings 

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  To check this setting, launch Microsoft Excel before opening the 
Natural Gas and Oil Systems module.  Go to the Tools menu and select “Options...” Click on 
the “Calculations” tab and make sure that the radio button next to “Automatic” is selected, 
and then click on “OK” to close the window.  The security settings (discussed next) can also 
be adjusted at this time. 

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  Go to the Formulas ribbon and select “Calculation Options.” Make 
sure that the box next to the “Automatic” option is checked from the pop-up menu. 

Microsoft Excel Security 

Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security 
set to medium (recommended) or low (not recommended).  To change this setting, launch 
Microsoft Excel before opening the Natural Gas and Oil Systems module.  Once in Excel, go 
to the Tools menu, click on the Macro sub-menu, and then select “Security” (see Figure 1).  
The Security pop-up box will appear.  Click on the “Security Level” tab and select medium.  
When set to high, macros are automatically disabled; when set to medium, Excel will give 
you the choice to enable macros; when set to low, macros are always enabled. 

When Excel security is set to medium, users are asked upon opening the module whether to 
enable macros.  Macros must be enabled in order for the Natural Gas and Oil Systems 
module to work.  Once they are enabled, the module will open to the control worksheet.  A 
message box will appear welcoming the user to the module.  Clicking on the “x” in the 
upper-right-hand corner of the message box will close it. 

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security 
Warning appears above the formula box in Excel when the Natural Gas and Oil Systems 
module is initially opened. The Security Warning lets the user know that some active 
content from the spreadsheet has been disabled, meaning that Excel has prevented the 
macros in the spreadsheet from functioning.  Because SIT needs macros in order to function 
properly, the user must click the “Options” button in the security message and then select, 
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“Enable this content” in the pop-up box. Enabling the macro content for the SIT in this way 
only enables macros temporarily in Excel but does not change the macro security settings.  
Once macros are enabled, a message box will appear welcoming the user to module.  Click 
on the “x” in the upper right-hand corner to close the message box. 

If the Security Warning does not appear when the module is first opened, it may be 
necessary to change the security settings for macros.  To change the setting, first exit out 
of the Natural Gas and Oil Systems module and re-launch Microsoft Excel before opening 
the Natural Gas and Oil Systems module.  Next, click on the Microsoft Excel icon in the top 
left of the screen. Scroll to the bottom of the menu and select the “Excel Options” button to 
the right of the main menu. When the Excel Options box appears, select “Trust Center” in 
left hand menu of the box.  Next, click the gray “Trust Center Settings” button.  When the 
Trust Center options box appears, click “Macro Settings” in the left-hand menu and select 
“Disable all macros with notification.”  Once the security level has been adjusted, open the 
Stationary Combustion module and enable macros in the manner described in the preceding 
paragraph. 

Viewing and Printing Data and Results 

The Natural Gas and Oil Systems module contains some features to allow users to adjust 
the screen view and the appearance of the worksheets when they are printed.  Once a 
module has been opened, you can adjust the zoom by going to the Module Options Menu, 
and either typing in a zoom percentage or selecting one from the drop-down menu.  In 
addition, data may not all appear on a single screen within each worksheet; if not, you may 
need to scroll up or down to view additional information. 

You may also adjust the print margins of the worksheets to ensure that desired portions of 
the Natural Gas and Oil Systems module are printed.  To do so, go to the File menu, and 
then select “Print Preview.”  Click on “Page Break Preview” and drag the blue lines to the 
desired positions (see Figure 2).  To print this view, go to the File menu, and click “Print.”  
To return to the normal view, go to the File menu, click “Print Preview,” and then click 
“Normal View.” 

Figure 1.  Changing Security Settings 

 
 

Figure 2.  Adjusting Print Margins 

 

Drag cursor 
to resize page 
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1.2 MODULE OVERVIEW 

This User’s Guide accompanies and explains the Natural Gas and Oil Systems module of the 
SIT.  The SIT was originally developed in conjunction with EPA’s Emissions Inventory 
Improvement Program (EIIP) in order to automate the steps states would need to take in 
developing their own emission estimates in a manner that was consistent with prevailing 
national and state guidelines.   The result was a user-friendly and comprehensive set of 
eleven modules that help users estimate greenhouse gas emissions at the state level.    

Because most state inventories developed today rely heavily on the SIT, User’s Guides have 
been developed for each of the SIT modules.  These User’s Guides contain the most up-to-
date methodologies that are, for the most part, consistent with the Inventory of U.S. 
Greenhouse Gas Emissions and Sinks (EPA 2023a).  Users can refer to the chapters and 
annexes of the U.S. Inventory to obtain additional information not found in the SIT or in the 
companion User’s Guide.  

In 2021, EPA began publishing the results of the Inventory of U.S. Greenhouse Gas 
Emissions and Sinks disaggregated by U.S. state (EPA 2023b) to make consistent state-
level GHG data available for all states for use by states, researchers, and the general public.  
However, EPA recognizes that there will be differences between the state-level estimates 
published by EPA and inventory estimates developed by states using the SIT or other tools.  
Inventories compiled by states may differ for several reasons, and differences do not 
necessarily mean that one set of estimates is more accurate, or "correct."  In some cases, 
the Inventory of U.S. Greenhous Gas Emissions and Sinks may be using different 
methodologies, activity data, and emission factors, or may have access to the latest facility-
level information through the Greenhouse Gas Reporting Program (GHGRP).  In other cases, 
because of state laws and regulations, states may have adopted accounting decisions that 
differ from those adopted by UNFCCC and IPCC to ensure comparability in national reporting 
(e.g., use of different category definitions and emission scopes consistent with state laws 
and regulations).  Users of state GHG data should take care to review and understand 
differences in accounting approaches to ensure that any comparisons of estimates are 
equivalent or an apples-to-apples comparison of estimates. 

The Natural Gas and Oil Systems module calculates methane (CH4) and carbon dioxide 
(CO2) emissions from all phases of natural gas systems (including production, transmission, 
venting and flaring, and distribution) and petroleum systems (including production, refining, 
and transport).  The module provides default data for all emission factors and provides 
some activity data; however, EPA encourages the use of more comprehensive data sources 
if they are available.  Currently default data are not available in the SIT for the 
transmission, and distribution of natural gas or the refining, and transportation of oil.  If 
using outside data sources, or for a more thorough understanding of the module, please 
refer to the following discussion for data requirements and methodology. 

1.2.1 Data Requirements 

To calculate CH4 and CO2 emissions from natural gas and oil systems, the following data are 
required: 

• The number of wells and offshore platforms; 

• Amount of natural gas vented and flared; 

• The number of miles of gathering pipeline; 
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• The number of gas processing plants and compressor stations; 

• The number of miles of transmission pipeline; 

• The number of miles of distribution pipeline, if possible, by type (e.g., cast iron, 
steel, plastic) 

• The total number of services (e.g., gas meters); 

• Data on oil production, refining, and transportation; and 

• Emission factors for each of the above activities. 

A complete list of the activities for which activity data and emission factors are necessary to 
complete the Natural Gas and Oil Systems module is provided in Table 1. 

Table 1.  Data Requirements for the Natural Gas and Oil Systems Module 
Module Worksheet Activity Data and Emission Factors Required 
Natural Gas - Production Number of wells 

Number of shallow-water off-shore platforms 
Number of deep-water off-shore platforms 
Emission factors for all of the above (MT CH4/well or platform) 

Natural Gas - 
Transmission 

Miles of gathering pipeline 
Number of gas processing plants 
Number of gas transmission compressor stations1 
Number of gas storage compressor stations1 
Miles of transmission pipeline 
Number of LNG storage compressor stations 
Emission factors for all of the above (MT CH4/unit) 

Natural Gas - Distribution Miles of cast iron distribution pipeline2 
Miles of unprotected steel distribution pipeline2 
Miles of protected steel distribution pipeline2 
Miles of plastic distribution pipeline2 
Number of services 
Number of unprotected steel services 
Number of protected steel services 
Emission factors for all of the above (MT CH4/unit) 
Emission factor for alternate method* (MT CH4/per mile of distribution 

pipeline) 
Natural Gas - Venting and 
Flaring 

Billion BTUs of natural gas vented and flared 
Emission factor (MT CO2/Billion Btu natural gas vented and flared) 

Petroleum Systems Barrels of oil produced 
Barrels of oil refined 
Barrels of oil transported 
Emission factor (kg CH4/1000 barrels) 

1 An alternate method is available in which only total transmission pipeline miles are required, and the 
number of gas transmission and storage compressor stations is calculated based on this entry. 
2 An alternate method is available in which only total distribution pipeline miles are required, rather 
than by pipeline type. 
 
1.2.2 Tool Layout 

Because there are multiple sections to complete within the Natural Gas and Oil Systems 
module, it is important to understand the module’s overall design.  The layout of the Natural 
Gas and Oil Systems module and the purpose of its worksheets are presented in Figure 3.   
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Figure 3.  Flow of Information in the Natural Gas and Oil Systems Module* 

 

* These worksheets are the primary worksheets used in the Natural Gas and Oil Systems module; subsequent 
worksheets are used to populate the default data and are provided for informational purposes only. 

1.3 METHODOLOGY 

This section provides instructions for using the Natural Gas and Oil Systems module of the 
SIT to estimate fugitive emissions from natural gas and oil systems.  Emissions are 
calculated for several subcategories, including the production, flaring, transmission, and 
distribution of natural gas and the production, refining, and transportation of oil.  Within the 
Natural Gas and Oil Systems module, it is important to account for emissions from natural 
gas and petroleum 
systems separately 
because the 
emission factors 
and methods are 
fuel specific.  
Because the 
methodology 
differs for each 
subcategory, they 
are discussed 
separately, and 
specific examples are provided. 

The Natural Gas and Oil Systems module automatically calculates emissions after you enter 
activity data for each worksheet (and select or enter the emission factors on the control 
worksheet).  The tool provides default data for venting and flaring of natural gas and the 
number of natural gas wells, but data must be obtained for the remaining subcategories 
(see Box 1 for suggestions on where to find data). The exclusion of default data for 
transmission and distribution and refining and transportation of oil causes the NGO module’s 
estimates to be much lower than U.S. Inventory.  

Box 1: State Energy Data Sources 
Note that no default activity data are available for the transmission or distribution of 
natural gas. If state-specific data sources are not available, users can obtain much of 
the required data from the Energy Information Administration (EIA) 
(http://eia.doe.gov). The Mineral Management Services (MMS) also provides a 
comprehensive source of data for off-shore oil and gas production activities 
(http://www.mms.gov). In addition, the Office of Pipeline Safety (OPS) has detailed 
and exhaustive data on all kinds of pipeline (transmission, gathering, distribution, 
services) that is accessible to the public on its website 
(http://ops.dot.gov/stats.htm). The SIT has more detailed recommendations for data 
sources for each activity on the gas and oil data sources worksheets. 

 

 

http://eia.doe.gov/
http://www.mms.gov/
http://ops.dot.gov/stats.htm
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The Natural Gas and Oil Systems module follows the general methodology from the National 
Inventory Report (NIR) GHG Inventory by U.S. State. However, not all GHG Inventory by 
U.S. State sources are included in SIT (e.g., meters in distribution segment). SIT does not 
have default data for the transmission and distribution of natural gas or the refining and 
transportation of oil, while the Inventory by U.S. State includes emissions estimates for all 
components of fossil fuel related activities, including production, transmissions, storage, and 
distribution as well as abandoned wells.  

This User’s Guide provides an overview of the estimation methodology used in the Natural 
Gas and Oil Systems module by walking through the following steps: (1) select a state; (2) 
enter emission factors and activity data for natural gas production; (3) enter emission 
factors and activity data for natural gas transmission; (4) enter emission factors and activity 
data for natural gas distribution; (5) enter emission factors and activity data for natural gas 
venting and flaring; (6) enter emission factors and activity data for petroleum systems; (7) 
enter additional emission sources; (8) review summary information; and (9) export data.   

For all subcategories, the basic process is to multiply the activity data by the emission factor 
to obtain the emission estimate, which is then converted to million metric tons carbon 
dioxide equivalent (MMTCO2E) by multiplying by the GWP of CH4 (28) and dividing by 106.  
The general equation used to calculate emissions from natural gas systems is shown in 
Equation 1.  The equation used for venting and flaring of natural gas is similar but includes 
the flaring percent and does not include the GWP because emissions are already in units of 
CO2, as shown in Equation 2.  The equation used for petroleum systems is shown in 
Equation 3. 

Equation 1.  General Emission Equation for Natural Gas Systems 

 

Equation 2.  Emission Equation for Venting and Flaring of Natural Gas 

 

Equation 3.  General Emission Equation for Petroleum Systems 

 
Step (1) Select a State  

To begin, select the state for which you would like to perform the analysis.  This step will 
automatically select the appropriate state default data for the remainder of the calculations 
throughout the tool.   

Step (2) Enter Emission Factors and Activity Data for Natural Gas Production  

Control Worksheet 

Emissions (MMTCO2E) = 
Activity Data (‘000 barrels) × Emission Factor (kg CH4/’000 barrels) ÷ 

1,000 (kg/MT) × 28 (GWP) ÷ 106 (MT/MMT) 
 

Emissions (MMTCO2E) = 
Activity Data (BBtu) × Emission Factor (MT CO2/BBtu) × % flared 

÷ 106 (MT/MMT) 

 

Emissions (MMTCO2E) = 
Activity Data × Emission Factor (MT CH4/unit activity data) × 28 

(GWP) 
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On the control worksheet, either select the default data provided or enter user-specified gas 
and activity-specific emission factors that will be used throughout the tool.  To proceed with 
the default emission factors, select the “Check/Uncheck All” button or check the default box 
directly to the right of individual yellow input cells.  Note that these numbers can be 
overwritten if you discover that the data for your state differ from the default data provided 
by the tool.  To enter user-specified inputs, enter data directly into the yellow input cells.  If 
the user-specific inputs do not match the default data in the control worksheet (i.e., the 
default value is overwritten), the text will appear red.  See Figure 4 for locations of the 
“Check/Uncheck All” buttons, individual default check boxes, and yellow input cells.  
Information on emission factors is discussed below. 

Figure 4.  Control Worksheet for the Natural Gas and Oil Systems Module 

 
 
Default emission factors are provided in the Natural Gas and Oil Systems module for all 
natural gas and petroleum system activities, or they can be provided by the user.  Examples 
of the emission factors being used are shown in each of the specific sector worksheet 
figures shown in subsequent steps.   

The emission factors for natural gas systems, except production, are based on a study by 
the Gas Research Institute and the U.S. Environmental Protection Agency (GRI 1996).  The 
study conducted a large survey of emissions from the natural gas industry and developed 
emission factors for three of the four natural gas activities in the SIT: processing, 
transmission (including storage), and distribution.  Within each segment, industry facilities 
and operations were analyzed to identify fugitive emissions, leaks, and vented emissions.  
The study identified approximately 100 components of natural gas systems that are CH4 
emission sources.  For each component, the study developed an emission factor.   

Select All Defaults 

Required Data 

Individual Default 
Data Check Boxes 
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This finely grained GRI data on emission factors is the “Tier 3” approach developed by the 
Intergovernmental Panel on Climate Change (IPCC 1997) and is used to develop emission 
estimates for the annual Inventory of U.S. Greenhouse Gas Emissions and Sinks.  However, 
to simplify the amount of data required in the SIT, each of the default emission factors 
provided accounts for emissions from several activities.  For example, the default emission 
factor for natural gas production per well approximates emissions not just from wells but 
also from pneumatic devices, dehydrator vents, Kimray pumps, gas engines, and well clean-
ups.  Therefore, if users are supplying state-specific emission factors, all aspects of 
emissions must be considered. 

For the natural gas production sector, enter emission factors on the control sheet in the 
yellow cells.  The default emission factors for natural gas wells vary by year and region, 
while the default emission factors for offshore deep-water and shallow-water platforms do 
not vary by region or year.  The emission factors for natural gas well production are based 
on the emission factors used in U.S. EPA (2023a) and are ultimately based on GRI data 
source estimates. 

Natural Gas Production Worksheet 

Most gas production is from gas or oil wells.  Gathering lines are used to bring raw gas to a 
collection point or points within a production field.  Because CH4 is the major component of 
natural gas, leaks or venting from the gathering systems result in CH4 emissions.   

Natural gas is usually processed in gas plants to remove and process the natural gas liquids 
and to prepare the natural gas for pipeline transportation.  During processing, natural gas is 
dried, and a variety of processes may be used to remove most of the heavier hydrocarbons, 
or condensate, from the gas.  Processed gas is then injected into the natural gas 
transmission system, and the heavier hydrocarbons are marketed separately.  Major CH4 
emission sources in the gas processing are compressor fugitives, compressor exhaust, 
vents, pneumatic devices, and blowdown. 

On the natural gas production worksheet, shown in Figure 5, the orange cells indicate where 
the required activity data are entered manually.  Default data for natural gas well 
production from EIA (2022c) is available for most states.  Emissions are calculated by 
multiplying activity data by the appropriate emission factor to obtain the total CH4 emissions 
in metric tons.  Then, the total emissions are converted into MMTCO2E, by multiplying by 
the GWP for CH4 (28) and dividing by 106 (Equation 1). 
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Figure 5.  Example of Activity Data and Emission Factors Applied in the Natural Gas 
Production Worksheet 

 

Step (3) Enter Emission Factors and Activity Data for Natural Gas Transmission  

Transmission pipelines are large diameter, high-pressure lines that transport gas from 
production fields, processing plants, storage facilities, and other sources of supply over long 
distances to local distribution companies or to large volume customers.  A variety of 
facilities support the overall system, including metering stations, maintenance facilities, and 
compressor stations located along pipeline routes.  Compressor stations, which maintain the 
pressure in the pipeline, generally include upstream scrubbers, where the incoming gas is 
cleaned of particles and liquids before entering the compressors.  Reciprocating engines and 
turbines are used to drive the compressors.  Major CH4 emission sources are chronic leaks, 
compressor fugitives, compressor exhaust, vents, and pneumatic devices.   

Control Worksheet 

On the control sheet, enter emission factors (in metric tons of CH4 per unit) for gathering 
pipeline, gas processing plants, gas transmission compressor stations, gas storage 
compressor stations, transmission pipeline, and LNG storage compressor stations. 

Emission Factors 

Required Activity Data 
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Natural Gas Transmission Worksheet 

For the transmission worksheet, an alternate method is available if data on the number of 
gas transmission and storage stations is not accessible.  To use the alternate method, check 
the box at the top of each year’s calculations, and make sure to enter 'miles of transmission 
pipeline’ in the activity data.  The tool will then estimate the quantity of these stations 
based on transmission pipeline mileage.  An example of the transmission worksheet is 
shown in Figure 6 (input cells shown in blue). 

Figure 6.  Example of Activity Data and Emission Factors Applied in the Natural Gas 
Transmission Worksheet 

 

Step (4) Enter Emission Factors and Activity Data for Natural Gas Distribution  

Distribution pipelines are extensive networks of generally small diameter, low-pressure 
pipelines.  Gas enters distribution networks from transmission systems at city gate stations, 
where the pressure is reduced for distribution within cities or towns.  Major CH4 emission 
sources are chronic leaks, meters, regulators, and mishaps. 

Control Worksheet 

If you are using the preferred method of calculating emissions from natural gas distribution, 
enter emission factors (in metric tons of CH4 per mile of pipeline) for cast iron distribution 
pipeline, unprotected steel distribution pipeline, protected steel distribution pipeline, and 
plastic distribution pipeline.  If you are using the alternate method, you need only enter an 
emission factor of metric tons of CH4 per mile of distribution pipeline (all types of pipeline).  
Then for both methods, enter the emission factors for all natural gas services (i.e., end-
users), for unprotected steel services, and for protected steel services.   

Required Activity Data Emission Factors 

Check box if no data for 
compressor stations 
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Natural Gas Distribution Worksheet 

For distribution, states are encouraged to use the method provided for calculating emissions 
from specific types of distribution pipeline.  However, an alternate method is offered based 
on a single emission factor for total distribution pipeline.  If data are unavailable for the 
mileage of specific pipeline types, then check the box at the top of each year’s calculations 
and enter the total pipeline mileage where indicated.  The green input cells in Figure 7 show 
where activity data are required.   

Figure 7.  Example of Activity Data and Emission Factors Applied in the Natural Gas 
Distribution Worksheet 

 

Step (5) Enter Emission Factors and Activity Data for Natural Gas Venting and 
Flaring  

Control Worksheet 

Enter the emission factor for natural gas venting and flaring on the control worksheet.  This 
emission factor must account for both vented and flared natural gas.  The default emission 
factor is taken from U.S. EPA (2023a). 

Natural Gas Venting and Flaring Worksheet 

The venting and flaring worksheet is unique because it calculates CO2 emissions from 
flaring, and it requires both activity data for the amount of natural gas vented and flared, 
and the percent of gas flared.  Default activity data are available in the SIT for most states 

Required Activity Data 

Emission Factors 

Check box for 
alternate method 
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from the EIA Natural Gas Navigator.1  An example of the use of the activity data, emission 
factor, and percent flared can be seen in Figure 8 (input cells are shown in pink).  While the 
required activity data for this worksheet is the total amount that is vented and flared, the 
emissions calculations are for the amount of gas that’s flared.  The SIT assumes that 80 
percent of this gas is flared and that the remaining 20 percent (i.e., the amount that’s 
vented) must be accounted for in the petroleum systems production category.  Because 
there is no default data for petroleum systems in the SIT, the user must make sure that the 
amount of gas flared is not double counted when calculating emissions from the petroleum 
systems category. 

Venting and flaring refer to the disposal of gas that cannot be contained or otherwise 
handled.  Venting and flaring activities are associated with combined oil and gas production 
and take place in production areas where gas pipeline infrastructure is incomplete, and the 
natural gas is not injected into reservoirs.   

Figure 8.  Example of Activity Data and Emission Factor Applied in the Natural Gas 
Venting and Flaring Worksheet 

 

Step (6) Enter Emission Factors and Activity Data for Petroleum Systems  

Control Worksheet 

The petroleum system emission factors used in the SIT are implied emission factors derived 
from U.S. EPA (2023a).  Using the available published oil system emission estimates, the 
implied emission factors were developed by dividing the emission estimates from each of 
the major activity groups (production, refining, and transportation) by the appropriate 
activity data at the national level.  These implied emission factors are calculated for each 
year in the SIT.  States are encouraged to use state-specific emission factors if data are 
available, as actual emissions depend on site-specific characteristics including facility 
design, operation, and maintenance. 

 

1 Available online at: https://www.eia.gov/dnav/ng/NG_PROD_WELLS_S1_A.htm  

Emission Factor 

Activity Data 
Percent Flared 

https://www.eia.gov/dnav/ng/NG_PROD_WELLS_S1_A.htm
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Petroleum Systems Worksheet 

Required data for the petroleum systems worksheet include the amount of oil produced 
(including venting), refined, and transported in the state.  Figure 9 shows an example of the 
data used for this sector, the yellow cells are input cells.  Default data are not provided in 
the SIT, so users must input data for emissions to be estimated.  If state-specific data 
sources are not available, users can obtain oil production data from EIA’s Petroleum Supply 
Annual.2 Refining data can be calculated using data from the Petroleum Supply Annual and 
the calculator provided in the SIT on the oil data sources worksheet.  Currently, no uniform 
data source has been identified for oil transportation activities, so in the absence of other 
information it is recommended that users assume that the amount of oil transported is 
equivalent to the amount of oil refined in the state.   

Figure 9.  Example of Activity Data and Emission Factors Applied in the Petroleum 
Systems Worksheet 

 

CH4 emissions from oil systems are estimated using the “Tier 1” approach developed by the 
IPCC (IPCC 1997).  The approach is simpler than the method used for natural gas systems, 
but it is also less accurate.  The SIT calculates emissions by multiplying the required state-
level data on oil production, refining, and transportation by the appropriate emission factors 
and summing across activity types to calculate total emissions, as shown in Equation 3.  The 
general sources of CH4 emissions from oil systems that should be accounted for can be 
categorized into emissions from: (1) normal operations, (2) routine maintenance, and (3) 
system upsets and accidents.   

 

2 Available online at: http://www.eia.gov/petroleum/supply/annual/volume1/.  

Emission Factors 

Activity Data 

http://www.eia.gov/petroleum/supply/annual/volume1/
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Normal operations include emissions from the day-to-day operations of a facility.  Oil 
production and transportation facilities can emit CH4 due to a wide variety of operating 
practices and factors, including emissions from pneumatic devices, leaks from system 
components, emissions from process vents, emissions from starting and stopping 
reciprocating engines or turbines, and emissions during drilling activities. 

Routine maintenance includes regular and periodic activities performed in the operation of 
the facility.  These activities may be conducted frequently, such as launching and receiving 
scrapers (pigs) in a pipeline, or infrequently, such as evacuation of pipes (“blowdown”) for 
periodic testing or repair.  In each case, the required procedures release gas from the 
affected equipment.  Releases also occur during maintenance of wells (“well workovers”) 
and during replacement or maintenance of fittings. 

System upsets are unplanned events in the system.  The most common upset is a sudden 
pressure surge resulting from the failure of a pressure regulator.  The potential for 
unplanned pressure surges is considered during facility design, and facilities are provided 
with pressure relief systems to protect the equipment from damage due to the increased 
pressure.  Relief systems vary in design.  In some cases, gases released through relief 
valves may be collected and transported to a flare for combustion or re-compressed and 
reinjected into the system.  In these cases, CH4 emissions associated with pressure relief 
events will be small.  In older facilities, relief systems may vent gases directly into the 
atmosphere or send gases to flare systems where complete combustion may not be 
achieved.  The frequency of system upsets varies with the facility design and the operating 
practices.  In particular, facilities operating well below capacity are less likely to experience 
system upsets and related emissions.  Emissions associated with accidents are also included 
in the category of upsets. 

Step (7) Enter Additional Emissions Sources to Additional Emissions Sources 

Worksheet if Applicable  

Users may use this worksheet to input data about additional emissions sources that are not 
included in this module or any other module. Additional emissions sources should be 
reported in MMTCO2e. Figure 10 shows two options for entering data into this worksheet 
(please select only one):   

Option A: Add up to ten additional emission sources in column B, lines 10-19. Select CO2 or 
CH4 from the dropdown menu in column C. Enter the emissions in MMTCO2e for each year 
1990-2021 in the yellow cells. 
  
Option B: Enter the total CO2 (line 29) and/or total CH4 emissions (line 30) for all other 
emissions sources for each year 1990-2021 in the yellow cells in MMTCO2e. 
 
Figure 10. Example Additional Emissions Sources Worksheet  
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For emission sources that do not have any default data or are not accounted for within the 
State Inventory Tool, state-level data are available here: 
https://www.epa.gov/ghgemissions/state-ghg-emissions-and-removals 
 

Step (8) Review Summary Information 

The steps above provide estimates of total emissions for each natural gas and oil activity.  
These are summed over all activities, for each year, and the information is collected on the 
summary worksheet.  The summary worksheet displays results in MMTCO2E, as well as by 
individual gas.  Additionally, the summary worksheet provides an overview of sources 
excluded from the current emission estimates.  Users should check this list to see if they 
wish to go back and enter data for any of the omitted activities.  Figure 10 shows the 
summary worksheet that sums the emissions from all sectors in the Natural Gas and Oil 
Systems module.  In addition, the results are displayed in graphical format at the bottom of 
the summary worksheet.   

 

https://www.epa.gov/ghgemissions/state-ghg-emissions-and-removals
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Figure 11.  Example of the Summary Worksheet in the Natural Gas and Oil Systems 
Module 

 

Step (9) Export Data 

The final step is to export the summary data.  Exporting data allows the estimates from 
each module to be combined later by the Synthesis Module to produce a comprehensive 
greenhouse gas inventory for the state. 

To access the “Export Data” button, return 
to the control worksheet and scroll down to 
the bottom (8).  Click on the “Export Data” 
button and a message box will open that 
reminds the user to make sure all steps of 
the module have been completed.  If you 
make any changes to the Natural Gas and 
Oil Systems module later, you will then 
need to re-export the results. 

Clicking “OK” prompts you to save the file.  The file is already named, so you only need to 
choose a convenient place to save the file.  After the file is saved, a message box will 
appear indicating that the data was successfully exported.   

While completing the modules, you are encouraged to save each completed module; doing 
so will enable you to easily make changes without re-running it entirely. 

Following data export, the module may be reset and run for an additional state.  
Alternatively, you may run the remaining modules of the SIT to obtain a comprehensive 
profile of emissions for your state.   

Note: the resulting export file should not be 
modified. The export file contains a summary 
worksheet that allows users to view the results, as well as 
a separate data worksheet with an unformatted version of 
the results. The second worksheet, the data worksheet, 
contains the information that is exported to the Synthesis 
Tool. Users may not modify that worksheet. 
Adding/removing rows, moving data, or making other 
modifications jeopardizes the ability of the Synthesis 
Module to accurately analyze the data.  
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1.4 UNCERTAINTY 

In the upper right-hand corner of the summary worksheet is a button: “Review discussion of 
uncertainty associated with these results.”  By clicking on this button, you are taken to a 
worksheet that discusses the uncertainty surrounding the activity data and emission factors, 
and how the uncertainty estimates for this source category affect the uncertainty of the 
emission estimates for your state. 

1.5 REFERENCES 

EIA, 2023a. EIA’s Monthly Energy Review. “September 2023 Monthly Energy Review.” 
Available at: https://www.eia.gov/totalenergy/data/monthly/pdf/mer.pdf  

EIA 2022b. EIA's Natural Gas Navigator. "Number of Producing Gas Wells." Available at: 
https://www.eia.gov/dnav/ng/NG_PROD_WELLS_S1_A.htm 

EIA 2022c. EIA's Natural Gas Navigator. "Number of Gas Producing Oil Wells." Available at: 
https://www.eia.gov/dnav/ng/NG_PROD_OILWELLS_S1_A.htm 

GRI.  1996.  Methane Emissions from the Natural Gas Industry, Gas Research Institute and 
U.S.  Environmental Protection Agency.  EPA-600/R-96-080a. 

IPCC. 1997.  IPCC Guidelines for National Greenhouse Gas Inventories, 3 volumes: Vol.  1, 
Reporting Instructions; Vol.  2, Workbook; Vol.  3, Draft Reference Manual.  
Intergovernmental Panel on Climate Change, Organization for Economic Co-Operation 
and Development.  Paris, France. 

U.S. EPA. 2023a. Inventory of U.S. Greenhouse Gas Emissions and Sinks: 1990 – 2021. 
Office of Atmospheric Programs, U.S. Environmental Protection Agency. EPA 430-R-23-
002. Available at: https://www.epa.gov/ghgemissions/inventory-us-greenhouse-gas-
emissions-and-sinks  

U.S. EPA. 2023b. Inventory of U.S. Greenhouse Gas Emissions and Sinks By State: 1990 – 
2021. Office of Atmospheric Programs, U.S. Environmental Protection Agency. Available 
at: https://www.epa.gov/ghgemissions/methodology-report-inventory-us-greenhouse-
gas-emissions-and-sinks-state-1990-2021 

 

 

https://www.eia.gov/totalenergy/data/monthly/pdf/mer.pdf
https://www.eia.gov/dnav/ng/NG_PROD_WELLS_S1_A.htm
https://www.eia.gov/dnav/ng/NG_PROD_OILWELLS_S1_A.htm
https://www.epa.gov/ghgemissions/inventory-us-greenhouse-gas-emissions-and-sinks
https://www.epa.gov/ghgemissions/inventory-us-greenhouse-gas-emissions-and-sinks
https://www.epa.gov/ghgemissions/methodology-report-inventory-us-greenhouse-gas-emissions-and-sinks-state-1990-2021
https://www.epa.gov/ghgemissions/methodology-report-inventory-us-greenhouse-gas-emissions-and-sinks-state-1990-2021

	1.1  Getting Started
	Microsoft Excel Settings
	Microsoft Excel Security
	Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security set to medium (recommended) or low (not recommended).  To change this setting, launch Microsoft Excel before opening the Natural Gas and Oil Systems module.  Once in ...
	When Excel security is set to medium, users are asked upon opening the module whether to enable macros.  Macros must be enabled in order for the Natural Gas and Oil Systems module to work.  Once they are enabled, the module will open to the control wo...
	Excel 2007 and Later: If Excel’s security settings are set at the default level a Security Warning appears above the formula box in Excel when the Natural Gas and Oil Systems module is initially opened. The Security Warning lets the user know that som...
	If the Security Warning does not appear when the module is first opened, it may be necessary to change the security settings for macros.  To change the setting, first exit out of the Natural Gas and Oil Systems module and re-launch Microsoft Excel bef...
	Viewing and Printing Data and Results

	1.2 Module Overview
	1.2.1 Data Requirements
	1.2.2 Tool Layout

	1.3 Methodology
	Step (1) Select a State
	Step (2) Enter Emission Factors and Activity Data for Natural Gas Production
	Step (3) Enter Emission Factors and Activity Data for Natural Gas Transmission
	Step (4) Enter Emission Factors and Activity Data for Natural Gas Distribution
	Step (5) Enter Emission Factors and Activity Data for Natural Gas Venting and Flaring
	Step (6) Enter Emission Factors and Activity Data for Petroleum Systems
	Step (7) Enter Additional Emissions Sources to Additional Emissions Sources Worksheet if Applicable
	Step (8) Review Summary Information
	Step (9) Export Data

	1.4 Uncertainty
	1.5 References

